w BS(M i Work Instruction
J Manage RA Catalog Views

Purpose

State Distributing Agency (SDA) and Indian Tribal Organization (ITO) Organizational Administrators (Org
Admins) use this procedure to create and maintain catalogs for their Recipient Agencies (RAs) and Co-
ops to allow ordering commodities from the Domestic Order Entry application. Maintenance includes
updating the view, as well as assigning/unassigning RAs and Co-ops from catalogs. This work instruction
applies to all USDA Domestic programs, although steps and graphics may refer to specific examples.
Where applicable, navigation guides and related notes indicate which steps apply for different types of
catalog items, including Multi-Food, Direct Delivery, and Processing Diversion.

The procedure to create and maintain an RA catalog view includes the following key steps:

Create and name new catalog (if applicable)
Update existing catalog
o  Add/remove commodities on a list of available products in catalog (View)
o  Assign/unassign RAs and Co-ops who may access the catalog through Domestic Order
Entry (Organization)
o  Save catalog updates
o Delete an RA catalog
. For Direct Delivery and Processing Diversion items, the SDA/ITO will also need to set or update
available ordering and delivery dates. See related training material, Maintain Direct-Ship
Delivery Periods for instructions.

Process Trigger

SDA/ITO Org Admins perform this procedure when they need to create or maintain a catalog to support
ordering by the assigned RA and Co-ops. This may be triggered by internal decisions or external factors
such as a notification from FNS that the master catalog for a program has been modified.

Prerequisites

. SDA Org Admin must have a program assigned by FNS.
) SDA must be linked to RA/Co-op as a sponsoring agency. Refer to the training
documents, Create Recipient Agency (RA), Maintain Recipient Agency (RA) and Create Co-

op Organization.
Portal Path

Follow the Portal path below to complete this transaction:

o Select Operations tab % Order Processing tab % Catalog Maintenance folder # Manage RA
Catalog Views link to go to the Manage RA Catalog Views screen.

Tips and Tricks

. The R/O/C acronyms in the field tables represent Required, Optional, or Conditional field entries.
o Required (R) — a mandatory field necessary to complete the transaction
o  Optional (O) — a non-mandatory field not required to complete the transaction
o  Conditional (C) — a field that may be required if certain conditions are met, typically
linked to completion of a mandatory field
. Refer to the WBSCM Help site, Frequently Referenced Training Materials section for basic
navigation training and tips on creating favorites, performing searches, etc.
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PROCEDURE

1. Start the transaction using the following Portal path: Operations tab 2 Order Processing tab =
Catalog Maintenance folder # Manage RA Catalog Views link.
Image: Manage RA Catalog Views Screen
Home Operations. Admin Help
Order Processing
, Operstions > Ordar Processing > Catalog Maintanance > Manape RA Catalog Views Full Screen || Options +
File Uplosds/Downloads Catalog Selecsion
Catalog Maintenance: ll_Cheose Catalog
Update
Entitliement Management
Catalog Already used Status
4000578C-ZFNS_CATALOG, FNS Master Catalog, FNS Variant Yes (=1 ]
l My Views
Catalog: 4000578C-ZFNS_CATALOG, FNS Master Catalog, FNS Variant
View Description Standard Activities
CACFP_DSL1 CACFP View Mo jEni; Delste
CSFF_DD Direct delfvery CSFP Mo Delet
Create New fisw
2. Click + (the Hide Navigator arrow) to minimize the Portal menu. Note that this can be done with
any transaction in WBSCM.
3. Perform one of the following:
If Then
The user wants to create a new RA catalog Go to Step 4.
The user wants to update an existing RA catalog  Go to Step 10.
The user wants to delete an existing RA catalog Select Delete (the Delete button). The catalog is

immediately deleted.
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Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help

Order Processing
Operations > Order Processing > Gatalog Maintenance > Manage RA Catalog \iews
Catslog Selection

Full Soreen || Options ~
)l_Choose Catalog

Update
Catalog Already used Status
4D0DSTEC-ZFNS_CATALOG, FNS Master Catalog, FNS Variant Yes 000
LMy Views
Catalog: AD005TEC-ZFN5_CATALOG, FNS Master Catalog. FNS Variant
View Desaription Standard Actities
CACFP_DSL1 CACFF View No Manage View/Organizafions  Delete
CSFP_DD Direct delivery CSFP No Manage View/Organizafions  Delete
Create New View

4. To create a new RA catalog, click Greate New\iew| (the Create New View button).

Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help
Order Processing
Operstions > Order Processing > Catalog Maintenance > Manage RA Catslog \iews

Catalog Selection > Create Wiew

Catalog: 4000573C-ZFNS_CATALOG, FNS Master Catalog, FNS Variant
I Create View

[ View*
| Deseription

Full Screen || Options ~

Crestz| Cancel
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5. As required, complete/review the following fields:
Field R/O/C Description
View™ R [The name given to the catalog view being created.
Example:

NSLP Materials

Description O [Text to identify and characterize an object or activity.

Example:
National School Lunch Program Materials

6. Click Crestz| (the Create button) to create the new view.

Image: Manage RA Catalog Views Screen

Home | Operations | Admin  Help
Order Processing
. Opersfions > OrderFrocessing > Catalog Maintenance > Manage RA Catalog Views Full Soreen || Options ~
Thank you!

‘Your view National School Lunch Program Materials for catslog 4000578C-ZFNS_CATALOG, FNS Master
Catalog. FNS Variant was sent. Please be patient, 3z this can taks some time

Back to Catalog View Mar ment

7. Click Backto Catalog View Management| (the Back to Catalog View Management button) to return to the
catalog selection screen.
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Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help

Order Processing

Operations > Order Processing > Gatalog Maintenance > Manage RA Catalog \iews
Catslog Selection

)_Choose Catalog

Full Screen || Options =
Update

Catalog Already u=ad Status
4000572C-ZFNS_CATALOG, FNS Master Catalog, FNS Variant Yes [alsls]

0 The catalog is temporarily unavailable. Try again later.

8. Click Update (the Update button) after the waiting period to refresh the list of available RA

catalog views. In this example, a new catalog view called National School Lunch Program
Materials was created to which the user can add commodities for an RA to view and order.

@ (Note) The waiting period is approximately 2-3 minutes. When the catalog has successfully

updated, the Status light will turn green after _Update
is available to view.

Perform one of the following:
If

(the Update button) is clicked, to indicate it

Then
The user wants to create another new RA catalog Go to Step 4.

The user wants to update an existing RA catalog ~ Go to Step 10.
(including newly created)
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Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help

Order Processing

Operations > Order Processing > Gatalog Maintenance > Maniage RA Catalog \iews

Full Soreen || Options ~
Catsiog Selection
)|_Choose Catalog
Update
Catalog Already used Status
4D0DSTEC-ZFNS_CATALOG, FNS Master Catalog, FNS Variant Yes 000
LMy Views
Catalog: 4000578C-ZFN5_CATALOG, FNS Master Catalog. FNS Variant
View Deseription Standard Activities
CACFP_DSL1 CACFF View Mo Manage View'Organizations  Delete
CSFP_DD Direct defivery CSFP No Manage View'Organizations  Delete
NSLP_MATERIALS Mational Schoal Lunch Program Matsrials Ho Manags Visw/Organizafions  Delete
Craate New Visw

10. Click Manag=‘iew'Drganzations (the Manage View/Organizations link) under the Activities column,

next to the catalog view to be reviewed and/or updated. In this example, National School Lunch
Program Materials is selected.

Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help
Order Processing
Operstions > Order Processing > Catalog Maintenance > Manage RA Catalog \iews

Full Screen || Options *
Catalog Selection > Maintain View

Catalog: 4000578C-ZFNS_CATALOG, FNS Master Catalog, FNS Variant
| _Maintain View

[ view

| Deseription

NELF_MATERIALS
Mational Scheol Lunch Program Materials

Process| Cancal
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11. As required, complete/review the following fields:

Field R/O/C Description

Description O Text to identify and characterize an object or
activity.
Example:

National School Lunch Program Materials

@ (Note) If needed, the user can change
: the description of the view by entering
new text in this field.

12. Click Frazzzs (the Process button) to open the selected RA catalog view.

13. Perform one of the following:
If Then
The user wants to update commodities available in Go to Step 14.
this catalog,

The user wants to update RAs/Co-ops assigned to Go to Step 21.
this catalog,

Image: Manage RA Catalog Views Screen

Home | Operations | Admin  Help

Order Processing
., Operstions > Order Processing > Catalog Maintenance > Manage RA Catalog Views Full Screen || Options +
Catalog Seiection > Maintain View > Manage View and Organizations
Catalog: 40005T3C-ZFNS_CATALOG, FNS Master Catalog, FNS VasiantView: National School Lunch Program Materials
l Manage View and Organizations
m Crganization
GSTEM | Find Product oKl
+ [l ropie Mo Products found
+ [l 1eeae Save View and Organizstion
+ [ cacer
+ [l srsp
¢ [nsie
14. To add/remove products in the RA catalog view, select the View tab if not already active.

@ (Note) The user can toggle between the screens for updating the list of materials (View)

and assigning RAs and Co-ops to a catalog (Organization) by clicking on the respective
tab.

(Note) Clicking 4 (the Arrow button) to the left of the Catalog also opens the catalog.
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Image: Manage RA Catalog Views Screen

Home | Operations | Admin  Help
Order Processing

Operstions * Order Processing > Catalog Maint=nance * Manage R Catslog Visws
Catalog Selection > Maintan View > Manage View and Organizations

Full Soreen || Opfions ~
Catalog: 40005T3C-ZFNS_CATALOG, FNS Master Catalog, FNS VasiantView: National School Lunch Program Materials
I Manage View and Organizations

m Crganizatian

] | Find Product oKl
v [eerp oK
+ LIFDPIR No Products found

+ O 1eeap Save View =nd Organizstion

+ [ cacer

+ O sFse

+ Onste

15.

Click the link for the desired program to update the materials available in the catalog. In this
example, NSLP was selected.

Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help

Order Processing

Operations > Order Processing > Catalog Maintanance > Manage RA Catalog Views Full Sereen || Options *
Catalng Selection > Maintain View > Manage Visw and Organizations

Catalog: 4000573C-ZFNS_CATALOG, FNS Master Catalog. FNS Variant View: National Schoal Lunch Program Materials
| Manage View and Organizations

D o
cataing Find Product kK|
+ [csrp !
+ [ Fopg Here you can edit your wiew by selecting the categories and i#ems that are to be contained. Each selection is transfermad automatioally. When you have edited your
+ [ 1EFAp. catalog view, choosz Organization in ordr 1o dispiay organizations and 1o 3ssign tham 1o the selected visw
+ [ cacre Search Results
+ [ sFsp
v [usie

_Cancel Selection |
NSLP Sawe View and Organization
+ [ Direct Delivery
* [ Processing Diversion

Progm Sub-Area Product
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16. Perform one of the following:
If Then
The user wants to add Direct Delivery 1.  Select DEctDelVery (the pirect Delivery
commodities to the catalog link).
2. Goto Step 17.
-ia (Note) Direct Delivery commodities are
available for the NSLP, CACFP, SFSP, NSIP,
CSFP, FDPIR, and TEFAP programs.
The user wants to add Processing Diversion 1. Select | Processing Diversion (the Processing
commodities to the catalog Diversion link).

2. Goto Step 17.

:-E (Note) Processing Diversion commodities
are available for the NSLP and CACFP programs.

The user wants to add Multi-Food commodities to Catalog

the catalog - L Eﬁﬂ
Multi-Food

1. Select MUY (the Multi-Food link)
2. Goto Step 17.

:-E (Note) Multi-Food commodities are available
for the CSFP and FDPIR programs.

@ (Note) Direct Delivery and Processing Diversion items are sourced directly from a vendor, and
RA orders undergo review, consolidation, and approval by the SDA/ITO. Multi-Food items are
sourced from the assigned National Warehouse, and orders do not require an approval process.
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Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help

Order Processing
Operstions > Order Processing > Catalog Maintenance > Manage RA Catslog \iews Full Screen || Options ~

Cafalog Ssizction > Maintain View > Manage View and Organizations
Catalog: 4000573C-ZFNS_CATALOG, FNS Master Catalog, FNS Variant View: National School Lunch Program Materisls
| Manage View and Organizations

m Cvpanizalian

2stalog Find Product oK
+ [ csep ! ad

+ [l ropie Here you can edit your view by seleciing the categories and items that are o be contained. Each selection is transfarred automatically. When you have edited your
+ [ 1Esp catalag view, chooss Organization in order to display erganizations and to 2ssign them to the selected view
+ O] cacep Search Results
+ [ sese Cancel Selection Program Sub-Area Product Name
v [ nste Save View and Organization
~ [ Direct Delivery
[ Mest
[ Poulty
L] Eish
(1 Vegetables
[ Beans (Canned and Dry}
[ Fruits (Canned, Dried, Fresh, Frozen
duice

[ Dairy

0] Grains

[ PastaiRice
our

Elour
Qs
Peanut/Sunflower

oo

e vvwvwvwwvwwows

|

17. Select the corresponding link to view the list of available commodities. For this example, Mzt
(the Meat link) category is selected.

(Note) Any commodity groups that have commodities already selected for RA ordering will show
(a checked Checkbox) to the left of the catalog.

Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help

Order Processing
Operstions > Order Processing > Gatalog Mainfenance > Manage RA Catalag Views Ful Sareen || Opfions ~
Catalog Selaction > Maintain View > Manage Viaw and Organizations
Catalog: 4000572C-ZFNS_CATALOS, FNS Master Catalog. FHS Variant View: Nations! Sehoal Lunch Program Materisls al
)L Manage View and Organizations
m organszaon
e Find Product oK
» Closer ! o]
+ [ ropir Hare you can edit your view by selecting the categories and items that 3re t be contained. Each sekection is transfired automatically When you have adited
* Oieesp your Gatalog wiew, choos= Organization in order 1o display organizations and fo assign them to the seiected view
» Ol cacre Search Results
» [lzese Selectal|  Progmm Sub-Area Product Mame
» Ousie [} NaLP Entitement 100127 BEEF CAN.2424 07
‘DI%" [m] NSLP Entitiement 100134 BEEF CRUMBLES WSPP PKG-4/10 L8
2 gL:m O NSLP Entitiemant 100158 SEEF FINE GROUND FRZ CTN-40 LB
e m| NSLP Entitlemant 100183 BEEF PATTY LEAN FRZ CTH-40 LB
» [ Paulry O NSLP Enditiement 100130 SEEF SPP PATTY HOMESTYLE CKD CTN-40LE
v [ Fish O NSLP Enditlemant 100181 BEEF 100% PATTY FRZ CTN-4018
* [ Vegetables [m] NSLP Enditiement 100184 ORK HAM WATERAD FRZ PKG 4410 LB
* [ Beans (Canned and Dry) [m] NSLP Entillement 100187 EORK HiM WATERAD 5LC FRZ PKG-8/5 18
:-E b O NSLP Entitiement 100128 EORK HAM WIRADCBEDFRZ PKG-4/10 OR &5 LB
v — O NSLP Enitiemant 100173 EORK ROAST LEG FRE CTN-324018
+ [ Grains O NSLF Entiement 100139 BORK CAN-2424 OF
I [m] NSLP Enitiemant 100144 PORK CRUMBLES 11l SPP PKG-4/10 LB
+ T Flowr m] NSLP Enitiemant 110730 BORK PULLED CKD PKG-85 L8
* Dok O NELP Entitiement 110082 SEEF IRRADIATED PATTY FRZ CTH-40LE
* [ Peanut/Sunflower O NELP Enfitiement 1100285 BEEF IRRADIATED FINE GRND FRE CTN-40 L8
¢ e O NSLP Endilamsnt 110261 BEEF FINE GROUND L FT OPT FRZ CTh-40 18
[m] NELP Entitemant 110270 BEEF LEAN PATTY LET OFT FRZ CTN-40 L8
[m] NELP Entitlemant 110284 SEEF CRUMBLES WSPF LFT OFT PKE4/10LE
ntilement /!
[m] NELP Enit 110288 BORK HAM WIRAD RDUSOD SLC FRZ PKG-B/5 LB
ntiliement J
] NSLP Entit 110348 BEEF 100% PTY 90/10 FRZ 2.0MMA CTN-40 LB o
O NSLP Entilemnent 110347 BEEF SPP PTY 85/15 FRZ 1.5 MMA CTN-40 LB
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18.

19.

20.

Select the corresponding link for the funding option to view the list of available commaodities. For
this example, Entitiemant (the Entitlement link) category is selected.

o

. (Note) The Entitlement option includes only commodities that can be ordered against the SDA's

and RA's entitlement balance. The Bonus option includes only commaodities that do not impact

entitlement balances when ordered.
Perform one of the following:

If

The user wants to select specific commodities from
the product list for the catalog view

Then

Select (the empty Checkbox) next to each
desired commodity to include in this RA catalog
view.

The user wants to select all the commodities from
the list for the catalog view

Click SelectAll] (the Select All button).

o

L= (Note) Always use this option for Multi-Food
commodities.

The user wants to de-select specific commodities
from the product list for the catalog view

Un-check |~/ (the checked Checkbox) next to
each desired commodity to remove from the RA
catalog view.

The user wants to de-select all the commodities
from the list for the catalog view

Click _Cancel Selection| (the Cancel Selection
button).

o

. (Note) To limit the list to a specific commodity or commodities that match search criteria,
enter the commodity number or name into the Find Product field. Then, click OK to

perform the search.

o

. (Note) Although a checkmark is not automatically applied next to the category in the

Catalog section on the left, selections are saved. The checkmark will appear after either
the Save View and Organization button is selected or another category is selected.

Perform one of the following:
If

The user would like to add other commodities to
this catalog view

Then
Go to Step 14.

The user would like to update RAs/Co-ops
assigned to this catalog view

Go to Step 21.

The user would like to save changes to the catalog Go to Step 27.

view
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Image: Manage RA Catalog Views Screen

Home | Operations | Admin  Help

Order Processing
Operafions > Order Processing > Gatalog Maintenance > Manage RA Catalog Views Full Screen || Opfions ~
Catalog Seiecion > Maintain View > Manage View and Organizations
Catalog: 4000574C-ZFNS_CATALOG, FNS Master Catalog, NS Viariznt View: Natonal Schoal Lunch Program Materizls
]| Manage View and Organizations
m Crganization
Catslog | Find Product OK|
+ M cerp 2]
+ O epeir Ho Products found
+ O 1eeap Save View and Organization
+ [ cacer
+ O sFse
+ Mnsie

21,

To add/remove organizations assigned to this catalog view, select __ &=t

(the Organization
tab) if not already active.

@ (Note) The user can toggle between the screens for updating the list of materials (View)

and assigning RAs and Co-ops to a catalog (Organization) by clicking on the respective
tab.

(Note) Users can perform the search without making any entries in the search fields. To

narrow the search results, enter data in one or more of the fields in the Search section. In
this example, the search fields are left blank.
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Image: Manage RA Catalog Views Screen

Home | Operations | Admin  Help

Order Processing
. Operafions > OrderProcessing > Gatalog Maintenance > Manage RA Catalag Views Full Soreen || Options ~

Catalog Sefzction > Maintain View > Manage View and Organizations
Catalog: 4000573C-ZFNS_CATALOG. FNS Master Catalog. FNS Variant View: National Schoal Lunch Program Materials
l Manage View and Organizations

Ssarch

1 Organization Name 1 Frogram 1 Additional Name
I Zone I City 1 County

Search| Display Al

Save View snd Organization | Selectll| Un-SelectAll|

22. As required, complete/review the following fields:

Field R/O/C Description
Organization Name O The legal name of the approved participating
organization in a USDA food program.

Example:
Food Bank

@ (Note) Enter full or partial RA or Co-

op Organization Name. Wildcard
search is available for this field.
Program O Acronym used to identify a USDA food distribution
program.

@ (Note) Enter the exact Program name.
Wildcard searches are not available for
this field.

Additional Name O Text to identify additional name.

@ (Note) Enter the full or
; partial Additional Name. Wildcard is

- available for this field.

Zone O Identifying number assigned to an RA by their
SDA.

@ (Note) Enter the exact Zone if known.
Wildcard search is available for this
field.
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Field R/O/C Description
City O City where the user or company is located.

@ (Note) Enter the full or partial City or
leave the field blank. Wildcard seacrh is
available for this field.

County O Region or geographical area.

@ (Note) Enter the full or partial County if
known. Wildcard search is available for
this field.

23. Perform one of the following:
If Then

The user has entered search criteria in any of the  Click -2222| (the Search button).
Search fields

The user would like to display all organizations Click Display Al] (the Display All button).
and programs

@ (Note) Refer to the Wildcard and Matchcode Searches Job Aid for advanced search options.

Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help

Order Processing
Operstions > Order Procassing > Catalog Maintenance > Manage RA Catalog Visws Full Scraen || Options =

Catalng Selection > Maintzin Visw > Manage View and Organizations
‘ Catalog: 4000573C-ZFNS_CATALOG, FNS Master Catalog. FNS Variant View: National School Lunch Program Materials
| Mznage View and Organizations

| e

toarch
| Crganizstion Name | Food Bank | Program | Aaditional Name
| Zane Iy | County

Search| Display All
Save View and Organization| Select All| Un-Salect Alll

Choose the users who can access this view

| Assign  Business Partner Organization Mame Additional Name Program Zone City County

| O 0004001181 Central Texas Food Bank CACFF CSFP STIM TEFAP 7 Austin Trauis
] 0004001987 Food Bank of Corpus Christ CACFF CSFP STIM TEFAP 4 Corpus Christ Nuaces

I O 0004001994 Food Bank of the Rio Grands Valley TEFAP CACFF CSFP STIM TEFAP 4 Brownsuillz Cameron
O 0004002423 Houstan Faod Bank CACFF CSFP NSLF NSIF STIM SFEP 4 Houstan Harriz

| [m] 0004003287 North Tesas Food BankiAbilens Food Bank CACFF CSFP STIM TEFAP 4 4bilens Taylor
O 0004003884 Regional East Texas Food Bank CACFF GSFP STIM TEFAP 4 Houston Harriz
O 0004003044 San Antonio Food Bank CACFF CSFP STIM TEFAP 4 San Antonio Bexar
[m] 0004004082 South Plsins Food Bank/High Fisins Food CACFF CSFP STIM TEFAP 4 ElPas ElFass

| O 0004004105 Southeast Texas Food BankFood Sank CACFF CSFP STIM TEFAP 5 Orange Orange
] 0004004630 Tamant Area Food Bank/Wichit Falls CACFF CSFP STIM TEFAP 5 Wichita Falls Wichita
O 0004005487 VWest Texas Food Bank CACFF CSFP STIM TEFAP 5 Lubbock Lubbock
O 0004005042 South Texas Food Bank CACFF CSFP TEFAP 5 Brownzille Cameron

Sava \iew and Organization| Select All| Un-Salect Al
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24. As required, complete/review the following fields:
Field R/O/C Description
Business Partner O Number or name assigned to SDAs, ITOs, Co-ops,
and RAs in WBSCM.
Organization Name O The legal name of the approved participating
organization in a USDA food program.
Q (Note) The Organization Name field
(L indicates the RA or Co-op name.
Program O Acronym used to identify a USDA food distribution
program.
Additional Name O Additional text for the organization's name.
Zone O Identifying number assigned to an RA by their
SDA.
City O City where the user or company is located.
County O Region or geographical area.
25. Perform one of the following:
If Then

The user would like to assign a specific

Click L (the empty Checkbox) next to each

organization from the list to this catalog view desired organization.

The user would like to assign all the listed
organizations to this catalog view

Click SelectAl] (the Select All button).

The user would like to unassign a specific

Uncheck ¥ (the checked Checkbox) next to each

organization from the list from this catalog view desired organization.
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If Then

The user would like to unassign all the listed Click Un-selectAl] (the Un-Select All button).
organizations from this catalog view

26. Perform one of the following:

If Then

The user would like to add or remove commodities Go to Step 14.
in this catalog view

The user would like to update RAs/Co-ops Go to Step 21.
assigned to this catalog view

The user would like to save changes to this catalog Go to Step 27.
view

Image: Manage RA Catalog Views Screen

Home | Operafions = Admin  Help

Order Processing
Operstions > Order Processing > Catalog Maintenance > Manage RA Catalog Views Full Screen || Options =

Catalog Selection > Maintsin View > Manage View and Organizations
‘ Catalog: 4000572C-ZFNS_CATALOG, FNS Master Catalog, FNS Variant View: National School Lunch Program Materials
I Manage View and Organizations

| View Drmanization

tmarch
| Crganizstion Mame | Food Bank | Program | Additional Name
| Zone | iy | County
Sesrch| Display All
Save View and Organization| Select All| Un-Salect All

Choose the users who can access this view

Assign | Business Partner Crganization Name Additienal Name Program Zone City County
0004001181 Central Texas Food Bank CACFP CSFP STIM TEFAP 7 Austin Travis
m} 0004001987 Food Bank of Corpus Christi CACFF CSFP STIM TEFAP 4 Corpus Christi Nuecss
[ O 0004001884 Food Bank of the Rio Grande Valley TEFAFP CACFF CSFP STIM TEFAP 4 Brownsuille Cameron
O 0004002423 Houston Food Bank CACFP CSFP NSLP NSIP STIM SFEP 4 Houston Harris.
| O 004003287 Morth Texas Food Bank/Abilene Food Bank CACFP CSFP STIM TEFAP 4 Ahilene Taylor
] 0004003884 Regional East Texas Food Bank CACFP CSFP STIM TEFAP 4 Houstan Harris
[m} 0004003344 San Antonio Food Bank CACFF CSFP STIM TEFAP 4 San Antonio Beuar
O 0004004082 South Plzins Food Bank/High Fiains Food CACFF CSFP STIM TEFAP 4 ElPazo ElPaso
! O 004004105 Southeast Texas Food BankFood Bank CACFP CSFP STIM TEFAP 5 Oranae Oranoe
O 0004004530 Tarrant Area Food Bank/Wichita Falls CACFF CSFP STIM TEFAP ] Wichita Falls Wichita
D 004005487 West Texas Food Bank CACFP CSFP STIM TEFAP g Lubbock Lubbock
] 0004005042 South Texas Food Bank CACFP CSFP TEFAP 5 Srovmaville Cameron

Save View and Organization| Select All| Un-Select All

27. Click _Eawe\iew and Organization| (the Save View and Organization button) to save any updates.
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Image: Manage RA Catalog Views Screen

Home | Operations = Admin  Help

Order Processing

. Opersiions > Order Processiny g > Catalog Maintenance > Manage RA Catalog Views

Thank you!
“¥our wiew National School Lunch Program Materials for catslog 4000578C-ZFNS_CATALOG, FN& Master

Catalog. FNS Variant vas sent. Pleass be patient. as this can take some time

Back to Catalog View Mansgement

28.

Click Back to Gatalop View Management| (the Back to Catalog View Management button) to return to the
catalog selection screen.

o

(Note) Click _Update (the Update button) in the Catalog View Management screen to refresh the
list of available RA catalogs. The waiting period is approximately 2-3 minutes. When the catalog

has successfully updated, the Status light will turn green after _Update (the Update button) is
clicked again. This will allow the user to release the catalog for other users within the agency.
29. The transaction is complete.

@ (Note) For RA catalogs that contain Direct Delivery and Process Diversion materials, the next

step is to set delivery periods and lead time to allow the SDA/ITO to review and consolidate RA
orders. Refer to the Maintain Ship-To Delivery Dates work instruction.
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RESULT

The user has successfully completed the steps to Manage RA Catalog Views by either creating a new
catalog view, or updating the products listed in and/or the organizations assigned to an existing one, or
deleting an RA catalog that is no longer needed.
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PROCESS OVERVIEW

Purpose

When placing an order, a Recipient Agency (RA) must select a delivery period to identify the range of
dates when the sales order should be delivered. Each delivery period is associated with an order due
date that is set by FNS. To allow additional time for reviewing and consolidating orders, the State
Distributing Agency (SDA) or Indian Tribal Organization (ITO) has the option to set additional lead time for
each commodity group. RAs must place orders within the specified number of days prior to the date
orders are due to FNS. The purpose of this transaction is for SDA/ITO Order Managers to select the
delivery periods that will be available to the RAs and to set lead time for each commodity group.

Process Trigger

A commodity was added to the domestic catalog. An SDA/ITO Order Manager needs to select the
delivery periods to be available to RAs for ordering and/or update the lead time for the commodity group.

Prerequisites

) An RA must exist as a suborganization to the SDA/ITO at the time delivery periods and lead time
settings are updated.

Portal Path
Follow the Portal path below to complete this transaction:

. Select Operations tab # Order Processing tab & Catalog Maintenance folder # Maintain
Direct-Ship Delivery Periods link to go to the Maintain Direct-Ship Delivery Periods initial
screen.

Tips and Tricks

. The R/O/C acronyms in the fields tables represent Required, Optional, or Conditional field
entries.
o Required (R) - a mandatory field necessary to complete the transaction
o  Optional (O) - a non-mandatory field not required to complete the transaction
o  Conditional (C) - a field that may be required if certain conditions are met, typically
linked to completion of a mandatory field
. Refer to the WBSCM Portal Navigation course for tips on creating favorites, performing searches,
etc.
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PROCEDURE

1. Start the transaction using the following Portal path: Operations tab 2 Order Processing tab =
Catalog Maintenance folder # Maintain Direct-Ship Delivery Periods link.

Image: Maintain Direct-Ship Delivery Periods Screen

Home Operations Admin Reports Help

Order Pri i Complaint Admini: Recall
Operstions > Order Processing > Cstalog Maintensnce > Msintain Direct-Ship Delivery Periods Full Screen || Options *

File Uploads/Downloads

Welcome to Maintain Direct-snip Delivery Periods
Plesse filter the Delivery Period results using the selection fields below.
Display RA Catalog Detes are formstted as MM/DDIYYYY

s o ety o s

Manage RA Catalog Views

Catalog Maintenance

Catalog Program: & | =] P
Order Management Carrenadity: [ 5] &
Entilement Management Product Description: & | | 5
Shipment Receipts FromDate: 9 [ |@ To 2
ToDate: & (ig] To &
L OrderbyDater & [ | To =
2. Click « (the Hide Navigator arrow button) to minimize the Portal menu. Note that this can be

done on any transaction in WBSCM.
Welcome to Maintain Direct-Ship Delivery Periods

Home DOperations Admin Reports Help

Order F i Ci i istrati Recall
Operaions » Order g = Catalop Mai » Maintsin Direct-Ship Delivery Periods

Full Screen || Options «

Welcome to Maintain Direct-Ship Delivery Periods
Please filter the Delivery Persiod results using the selection fields below.
Dates are formatted as MMDD/YYYY

Search / Filter Delivery Periods E
Cetalog Program: @ | = 4
Commadity. [ = L
Froduct D @ | | - 3
FromDatee & [ [@] [ m&
Topate @ [ M [ W&
OrderbyDater & [ |E [ ma
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Maintain RA Delivery Periods and Order Lead Time

3. As required, complete/review the following fields:
Field R/O/C Description
Catalog Program R The program associated with the commodity.
Example:
CSFP
Commodity R A Commodity is a substance that is bought or sold
on a commercial basis, or is used, consumed, or
created in production. It is usually identified by a
number identifying its master record.
Example:
100127
Product Description |0 Information used to characterize a material.
From Date O Beginning date.
@ (Note) Users can enter a single date or
Pt a range of dates. Enter end date of
range in the
1EA42E9629D548D187FD88222DE5S5
65B61DAE25139534354BB63324476A
7D0OBCTo
field. 1TEA42E9629D548D187FD88222D
E5565B61DAE25139534354BB633244
76A7D0OBC
To Date O Ending date for specifying a delivery time period.
@ (Note) Users can enter a single date or
(¥ a range of dates. Enter end date of
range in the
1EA42E9629D548D187FD88222DE5S5
65B61DAE25139534354BB63324476A
7D0BCTo
field. 1TEA42E9629D548D187FD88222D
E5565B61DAE25139534354BB633244
76A7D0OBC
Order by Date O Last date to submit orders for the corresponding
Delivery Date.
@ (Note) Users can enter a single date or
bt a range of dates. Enter end date of
range in the
1EA42E9629D548D187FD88222DE5S5
65B61DAE25139534354BB63324476A
7D0OBCTo

Thursday, April 29, 2021
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Field R/O/C Description

field. 1EA42E9629D548D187FD88222D
E5565B61DAE25139534354BB633244
76A7D0OBC

@ (Note) Refer to the Wildcard and Matchcode Searches Job Aid for tips to search for or select
values from a list.

Image: Maintain Direct-Ship Delivery Periods Screen

Home DOperations Admin Reports Help

Order Pr i Complaint Administrati Recall Administrati
Operations » Order g > Cstalog Msi > Maintsin Di hip Delivery Periods Full Screen || Options +
Welcome to Maintain Direct-Ship Delivery Periods
Plesse filter the Delivery Period results using the selection fields below
Dates are formatted as MM/DDYYY
Search / Filter Delivery Periods -
Catalog Program: @ [CEFP [x] 4
Commadity- [1oo127 ] =
Froduct D @ | | - 3
From Date: & i} To M =
ToDate: @ L
OrderbyDater & [ |H [ me

4. Click (the Search / Filter button) to perform the search. All available delivery
periods that match the selection criteria will display.

@ (Note) Delivery periods for a commodity are created by FNS; SDA/ITO Order Managers cannot
create new delivery periods.
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Image: Maintain Direct-Ship Delivery Periods Screen

Home | Operaions = Admin  Repors  Help

Order i Complaint Administrati Recall
Operstions > Order Frocessing > Catalog Maintenance > Msintain Direct-Ship Delivery Pariods Full Sereen || Options *

A
Commodity Delivery Periods by Program

View: | [Sandard View] -] &

Select Progam Commodty FProdustDescripion  FromDate ToDate  OrderDate =)
[]  GSFF 100127 BEEFCAN-242407 ODRIDIZ0IE DBASE018 0AO12016 | |
] CSFP 100127  BEEFCAN-26240Z 0882016 081202018 08012018 | |
[ ©SFP 100127  BEEFCAN24240Z 07012018 07152018 0610172018
[] CSFP 100127  BEEFCAN-24240Z 0TA62016 073172018 0810172018
[] CSFP 100127  BEEFCAN-242407 0012018 01152018 0610112018
[ ©SFP 100127  BEEFCAN242¢07 02162016 0213172018 06012018
[  ©SFP 100127  BEEFCAN-24240Z ORO12016 OB/152018 0BI0I/2018
[ ~©SFP 100127  BEEFCAN-242407 0DAG2016 00302018 081012018
[] CSFP 100127  BEEFCAN-242407 10012016 10/152018 071262018
[] GSFP 100127  BEEF CAN-24240Z 1062018 10312018 071222018 5]

[[ & Submit Delivery Pericds

_Maintain Lead Times

iaw: | [Standard View] ~| -

Frogram  Commodity Group  Lead Time Days =

CSFP CEREAL 1

OSFF  DAIRY o

CSFP FISH of

CSFP FLOUR 0|

CSFP  FRUTS 2|

CSFP  GRAINS 2| b

5. In the Commodity Delivery Periods by Program section, perform one or more of the following:

If Then
The user wants to select all delivery periods
Click Sl (the Select all button)

The user wants to select specific delivery period(s)

Click [ (the checkbox icon) next to the line item
The user wants to deselect all delivery period(s)  click [[JDe-Selectall| 1h¢ pe-Select all button)

The user wants to unselect specific delivery Click ¥l (the checked box icon) next to the line
period(s) item

@ (Note) SDA/ITOs determines which delivery periods will be available to their suborganizations.
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Image: Maintain Direct-Ship Delivery Periods Screen

Home | Operafions | Admin  Repors  Help

Order i Gomplaint Administrat Recall
= Operations > Order Processing » Catalog Maintenance > Maintain Direct-Ship Delivery Pesiods Full Soreen || Opiions =
)
Commodity Delivery Periods by Program
[T TD=Selectal
Viaw: | [Standard View] I+ 8

Select Frogam Commodity Product Descripion  FromDate ToDate  OrderDate =

| CEFP 100127 BEEF CAN-24/24 OZ 06/01/2016 08/15:2018 080172018
[ CSFP 100127 BEEF CAN-24/24 OZ D8/18/2018 08/20:2018 06012018
|] CSFFP 100127 BEEF CAN-24/24 07 07/012018 07152018 08/012018
1~ CSFP 100127 BEEF CAN-24/24 OZ 07/16/2018 07/31/2018 060172018
[] CSFP 100127 BEEF CAN-24/24 OZ 08101/2018 08152018 08/0172018
|| CSFP 100127 BEEF CAN-24/24 OZ 08182018 08/31/2018 06/01:2018
[ CSFP 100127 BEEF CAN-24/24 OZ 00/01/2018 08/152018 060172018
[ CSFP 100127 BEEF CAN-24/24 0Z 0182018 08/20:2018 06012018
|v| CSFP 100127 BEEF CAN-24/24 0OZ 10,01/2018 10152018 07/262018
1] CSFP 100127 BEEF CAN-2424 OZ 10/18/2018 107312018 07T/Z22018 |+

[[T& Submit Delivery Periods |
Maintain Lead Times
View: | [Standard View] = o

Progiam  Commodity Group Lead Time Days =)

CSFP  CEREAL 1]

CSFP DAIRY of

CSFP FIEH L]

CSFP FLOUR of

CSFP FRUITS 2|

CSFP GRAINS z v
6. Click L= Submit Delvery Periods | (the Submit Delivery Periods button) to apply the selected delivery

periods to all assigned RAs.

; (Note) When changes are applied, the message Data was saved successfully! displays at the
top of the screen.

Image: Maintain Direct-Ship Delivery Periods Screen

Home | Operafions | Admin  Repors  Help

Order i Gomplaint Administrati Recall

Operations > Order Processing > Catalog Maintenance > Maintain Direct-Ship Delivery Periods Full Sereen || Options =
Select Program Cammedity ProductDesoripion  FromDate ToDate  OrderDate a) w
# ~ CSFP 100127  BEEFCAN-24240Z 06012016 O0B/52018 0810172018
¥  CSFP 100127  BEEFCAN-24240Z 0682018 0B/302018 0BI01/2018 |
[  CSFP 100127  BEEFCAN24240Z 07012018 07152018 0610172018
W GSFP 100127  BEEFCAN-24240Z 07TA62018 073172018 0810172018
W CSFP 100127  BEEFCAN-242407 0012016 021152018 0810172018
¥ CSFP 100127  BEEFCAN-242407 062016 02312018 0610172018
¥ CSFP 100127  BEEFCAN24240Z O0DOV2016 O0D/152018 06012018
¥  CSFP 100127  BEEFCAN-24240Z O0BAG2016 0S/30/2018 0BN01/2018
[  CSFP 100127  BEEFCAN-242407 10012016 10152018 071262018
¥/ CSFP 100127  BEEFCAN-24240Z 107162018 10312018 071222018 |5

[[T& Submit Delivery Periods |

_Maintain Lead Times
View | [Sancard Viey] || X
Program  Commodity Group  Lead Time Days |
CSFP CEREAL 1|
CSFP DARY of
CSFP FISH 0|
CSFP  FLOUR of
CSFF  FRUITS 2|
CSFF GRAINS 2|
CSFP  JUICE 2/
CSFP  MEAT 0
CSFP MISC H
CSFP OIS o5

>

Thursday, April 29, 2021 © WBSCM Training - Proprietary Page 6 of 8



WBSCA |

Work Instruction

Maintain RA Delivery Periods and Order Lead Time

7. In the Maintain Lead Times section enter the number of Lead Time Days for the appropriate

Commodity

o

=

Group. In this example, a lead time of 5 days was entered for the FISH.

(Note) Lead time is entered as a number of days in advance of the date orders are due to FNS
for a delivery period. This gives the SDA/ITO additional time to review and consolidate orders.
For example, if orders are due to FNS on 10/1 and the SDA/ITO has set the Lead Time Days at
5, the RA must submit their order to SDA/ITO no later than 9/25.

Lead time is always set for the commodity group—not a specific commodity; for example, all
“MEAT” would have the same lead time.

Image: Maintain Direct-Ship Delivery Periods Screen

Home | Operations

Admin  Reports  Help

Order il Complaint Wi it Recall
Operations > Order Processing > Catalog Maintenance > Maintain Direot-Ship Delivery Periods Full Screen || Options =
Select Program Commodity Product Descripfion From Date  To Date Order Date _‘_ o~
Iv| CSFP 100127 BEEF CAN-24/24 OZ 06/01/2016 06/152018 06/01/2018
1 CEFP 100127 BEEF CAM-24/24 OZ 06/18/2016 06/30v2018 080172018
| CEFP 100127 BEEF CAN-24124 OZ 07/012018 07152018 080172018
Iv| CSFP 100127 BEEF CAN-24/24 OZ 07182018 07/3172018 060172018
1] CSFP 100127 BEEF CAN-24/24 07 08012018 08152018 06012018
1] CSFFP 100127 BEEF CAN-24/24 OZ 08/18/2016 08/31/2018 08/01/2018
15 CSFP 100127 BEEF CAN-24/24 OZ 08/01/2016 08/1520168 060172018
|v| CSFFP 100127 BEEF CAN-24/24 07 081182016 08/30:2018 08/01/2018
|v| CSFP 100127 BEEF CAN-24/24 OZ 10401/2018 10/152018 07/282018
|| CEFP 100127 BEEF CAN-24/24 OZ 10/16/2018 10/31/2018 07/222018 =
Maintain Lead Times
View: [SEndard View] %] 2s
Program  Commodity Group  Lead Time Days  *
CSFP CEREAL 1|
CsSFP DAIRY 0
CSFP FISH 5
CSFP FLOUR 0
CSFP FRUITS -
CSFP GRAINS 2|
CSFP JUICE 2
CSFP MEAT 0
CSFP MISC z
CsSFP oILs 0=
[ St ez T >
8. Click LIS uemitle=d Time | (16 Submit Lead Time button) to apply the selected lead time to all

assigned RAs .

@

——

9. This transac

(Note) When changes are applied, the message Data was saved successfully! displays at the top
of the screen.

tion is complete.

Thursday, April 29, 2021
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RESULT
An SDA/ITO Order Manager selected delivery periods and entered lead time for all assigned RAs.
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PROCESS OVERVIEW

Purpose

The purpose of this procedure is for a user logged in as a State Distributing Agency/Indian Tribal
Organization (SDA/ITO) to view and export a domestic catalog view maintained for their Recipient
Agencies (RAs). SDA/ITOs can ensure that the catalog has been set up accurately by viewing it as it
would appear to an RA; they also have the ability to download a catalog to either communicate the
products/delivery dates to the RAs or for preserving the information for review. This document includes
process steps to review a catalog prepared for an RA as well as export the catalog.

SDA/ITOs create catalogs for RAs for the following programs:

TEFAP - The Emergency Food Assistance Program

NSIP - Nutrition Services Incentive Program

NSLP - National School Lunch Program

SFSP - Summer Food Service Program

CACFP - Child and Adult Care Food Program

CSFP - Commodity Supplemental Food Program

FDPIR - Food Distribution Program on Indian Reservations
DA - Disaster Assistance

Process Trigger

Perform this transaction after creating or updating an RA catalog view.

Prerequisites
. The RA Catalog view must exist in WBSCM
Portal Path

Follow the Portal path below to complete this transaction:

o Select Operations tab % Catalog Maintenance folder % Display RA Catalog link to go to the
Display RA Catalog screen.

Tips and Tricks

. The R/O/C acronyms in the field tables represent Required, Optional, or Conditional field entries.
o Required (R) — a mandatory field necessary to complete the transaction
o  Optional (O) — a non-mandatory field not required to complete the transaction
o  Conditional (C) — a field that may be required if certain conditions are met, typically
linked to completion of a mandatory field
. Refer to the WBSCM Help site, Frequently Referenced Training Materials section for basic
navigation training and tips on creating favorites, performing searches, etc.
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1. Start the transaction using the following Portal path: Operations tab % Catalog Maintenance
folder % Display RA Catalog link to go to the Display RA Catalog screen.

Image: Display RA Catalog Screen

Home Operations Admin Reporis Help

Order Processing
Op i > Order P i = Catalog Mair > Display RA Cataleg Full Screen | Opfions
File Uploads/Downloads
Catalog Maintenance Select Business Partner |E|
Maintain Direct-Ship Deliver. . Program: < | “ =
Order Management Include Mulfi-Food?: E
Shipment Receipts
= Submit
NW Delivery Calendar
2. Click * (the Hide Navigator arrow) to minimize the Portal menu. Note that this can be done

with any transaction in WBSCM.
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Image: Display RA Catalog Screen

Home Operations Admin

Order Processing

Operations > Order Processing > Catalog Maintenance >

Reports

Help

Display RA Catalog Full Screen | Options ~

Select Business Partner =
RA Organization: * [ [
Program: > | & =
Include Multi-Food?. | |
3. As required, complete/review the following fields:
Field R/O/C Description
RA Organization: * R The Recipient Agency.
Example:
4001181
@ (Note) Only one RA Organization can
b be selected at a
time.1EA42E9629D548D187FD88222D
E5565B61DAE25139534354BB633244
76A7D0OBC
Program: O Acronym to identify a USDA food distribution
program.
Include Multi-Food?: |O \When checked, multi-food commodities are
included.
@ (Note) The
b 1EA42E9629D548D187FD88222DES5
65B61DAE25139534354BB63324476A
7D0BClInclude Multi-Food?: field
defaults to
unchecked.1EA42E9629D548D187FD8
8222DE5565B61DAE25139534354BB6
3324476A7D0OBC
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Image: Display RA Catalog Screen

Home Operations Admin Reports Help

Order Processing
Operations > Order Processing > Catalog Maintenance = Display RA Catalog Full Screen | Options
Select Business Partner =

RA Organization: = =] 4001181
Program: < | 7 =
Include Multi-Food?. | |

= Submit

4. Click (the Submit button) to display the catalog for the selected RA Organization.
Image: Display RA Catalog Screen

Home Operations Admin Reporis Help

Order Processing
Operations > Order Processing > Catalog Mainfenance > Display RA Catalog Full Screen | Oplions ~
.
Select Business Partner N

RA Organization: * =] [4001181
Pragram: < | T =
Include Multi-Food?: O

Display RA Catalog

RABP: 4001131 | RA Name: Central Texas Food Bank

View: [CATALOG VIEW | =||

xport 4

Program = Program Sub-Type = Catalog Type = Program Type = Product Group = Product Number = Product Description Unit
CSFP Direct Delivery Cereal Entitliement CEREAL, FORTIFIED 100530 CEREAL CORHN FLKS -SUBST LB
o CEREAL CORMN FLKS -SUBST LB
o CEREAL CORHN FLKS -SUBST LB
CEREAL CORN FLKS -SUBST LB
o CEREAL CORN FLKS -SUBST LB
| CEREAL CORN FLKS -SUBST LB
CEREAL CORN FLKS -SUBST LB
CEREAL CORHN FLKS -SUBST LB
CEREAL CORN FLKS -SUBST LB |ag
CFRFAI CORN FIKS _SURST IR
< >
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5. As required, complete/review the following fields:
Field R/O/C Description
Program O Acronym to identify a USDA food distribution
program.

Program Sub-Type

O

\Within a USDA program, distinguishes the sub-
program used to process and deliver products.

Q (Note)
bt 1EA42E9629D548D187FD88222DE55
65B61DAE25139534354BB63324476A
7D0OBCProgram Sub-Types include
the following:
e Direct Delivery
e Processing Diversion
e  Multi-
Food1EA42E9629D548D187F
D88222DE5565B61DAE25139
534354BB63324476A7D0BC

Catalog Type

The type of product included in a catalog.

Q (Note) All catalog types do not apply to
. all programs. Each program has a
unique set of catalog types associated
with

it. 1TEA42E9629D548D187FD88222DE5
565B61DAE25139534354BB63324476
A7DOBC

@ (Note) For multi-food entries and the DA
-l Program, this field will be
blank.1EA42E9629D548D187FD88222
DE5565B61DAE25139534354BB63324
476A7D0OBC

Program Type

The manner in which a program is funded.

@ (Note)
i 1EA42E9629D548D187FD88222DE5S5
65B61DAE25139534354BB63324476A
7DOBCProgram Types include:
e Entitlement
e Bonus1EA42E9629D548D187F
D88222DE5565B61DAE25139
534354BB63324476A7D0BC

@ (Note) For Multi-Food entries and

=S the DA Program, this field will be
blank.1EA42E9629D548D187FD88222
DE5565B61DAE25139534354BB63324
476A7D0OBC
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Field R/O/C Description

Product Group O Group to which the product or material belongs.
Product Number O Unique identifier assigned to a product.

Product Description |0 Information used to characterize a material.
Unit O Unit of measurement (such as cases or pounds)

for ordering products.

RA Order By Date O The date by which the RA must place the order.

Example:

@ (Note) The
(T 1EA42E9629D548D187FD88222DES5S5
65B61DAE25139534354BB63324476A
7DOBCRA Order By Date is calculated
by subtracting the SDA Lead Time from
the FNS Order By
Date.1EA42E9629D548D187FD88222
DE5565B61DAE25139534354BB63324

476A7D0OBC
@ (Note) For Multi-Food entries, this field
ol will be "Not

Applicable".1EA42E9629D548D187FD
88222DE5565B61DAE25139534354BB
63324476A7D0OBC

SDA Lead Time O The number of days prior to the FNS Order By
Date that the RA has to submit their requisitions to
the SDA for review and consolidation.

@ (Note) For Multi-Food entries, this field
p 1 will be

zero.1EA42E9629D548D187FD88222D
E5565B61DAE25139534354BB633244

76A7D0OBC
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Field R/O/C Description

Vg

FNS Order By Date |0 The date by which FNS requires the consolidated
order to be submitted.

(Note) For Multi-Food entries, this field
will be
blank.1EA42E9629D548D187FD88222
DE5565B61DAE25139534354BB63324
476A7D0OBC

Vg

Deliver By Date 0] The date by which the products should be
delivered.

(Note) The 'NO Delivery Date Set"
value will appear under

the 1EA42E9629D548D187FD88222D
E5565B61DAE25139534354BB633244
76A7DOBCRA Order By Date column
field when SDAs do not assign to their
RA
View.1EA42E9629D548D187FD88222
DE5565B61DAE25139534354BB63324
476A7D0OBC

(Note) For Multi-Food entries, this field
will be
blank.1EA42E9629D548D187FD88222
DE5565B61DAE25139534354BB63324
476A7D0OBC

6. Perform any of the following:
If
The user needs to download RA catalog view

Then

1. Click B¥P°m4 (the Export button) to export

the catalog view data.

2. Click Export to Microsoft Excel (the Export

to Microsoft Excel button).

3. Click. 2P | (the Open button).
4. Review and save the spreadsheet as
appropriate.
5. Click “ (the Close button) to close the
spreadsheet and return to the transaction.
The user needs to customize the appearance of 1. Click * &» (the Open Settings button)
the RA catalog located on the right side of the screen.
2.  As appropriate, select fields in the Hidden
Columns and click (the
Add button) to add columns to the
displayed view.
3.  As appropriate, select fields in the

Displayed Columns and click

4 EMOve (the Remove button) to
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If Then

remove columns from the displayed view.
4. As appropriate, select fields in the
Displayed Columns and click

IE' IE' IE' El (the Up/Down arrows) to

change the column order.

5. Click (the Save as...button) to

save the new view.
6. Name the new view in the Description
field.

7. Click (the OK button).

;_E (Note) The new view can be selected from
the Views field the next time the transaction is
required.

;E (Note) The RA catalog view can be
downloaded after making changes to the columns.

The user needs to limit the amount of information 1. Click * &= (the Open Settings button)
displayed located on the right side of the screen.

2.  Click i “Filter’ (the Filter tab).

3. Click [/ (the Drop-down button) in the first
field to select the column to be filtered from
the drop-down list.

4. Click LE (the Matchcode button) in the third
field to select a value for which filtering is
required.

5. Review the filtered display as appropriate.

LE (Note) Only records that match the applied
filter(s) will be displayed.

9

L (Note) The RA catalog view can be
downloaded after applying a filter.

@ (Note) Export file download prompt may appear different based on the user's browser.

7. The transaction is complete.
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RESULT

The SDA/ITO has reviewed the RA catalog details, using the available tools to customize the appearance
of or apply filters to the catalog, as applicable. If appropriate, the SDA/ITO may also have exported the
view as a spreadsheet for further review, record-keeping, or sharing outside of WBSCM.
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WBS(AM | Download Catalog

PROCESS OVERVIEW

Purpose

This transaction enables a State Distributing Agency (SDA) or Indian Tribal Organization (ITO) to export a
catalog from WBSCM to their computer. The catalog can be filtered by program, delivery dates, and NLT
dates. Results are generated in XML or CSV format and may be displayed, printed, or saved.

Process Trigger
Use this procedure to download the catalog in XML or CSV format.
Prerequisites

. Catalog view must be assigned to SDA/ITO.
. Materials must exist in WBSCM.
. Delivery periods and NLT dates must be set up for the materials.

Portal Path
Follow the Portal path below to complete this transaction:

. Select Operations tab @ Order Processing tab 2 File Uploads/Downloads folder & Download
Catalog link to go to the Download Catalog screen.

Tips and Tricks

. The R/O/C acronyms in the field tables represent Required, Optional, or Conditional field entries.
o Required (R) - a mandatory field necessary to complete the transaction.
o  Optional (O) - a non-mandatory field not required to complete the transaction.
o  Conditional (C) - a field that may be required if certain conditions are met, typically
linked to completion of a mandatory field.
o Refer to the WBSCM Help site, Frequently Referenced Training Materials section for basic
navigation training and tips on creating favorites, performing searches, etc.
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PROCEDURE

1. Start the transaction using the Portal path: Operations tab 2 Order Processing tab =
File Uploads/Downloads folder #Download Catalog link.

Image: Download Catalog Screen

Home Operations Admin Reports Help

Order Processing
Operations > Order Processing > File Uploads/Downloads > Download Catalog Full Screen || Options »

File Uploads/Downloads

- Download Catalog Catalog Selection

Download Purchase Orders Program: CSFP ~
Download Sales Orders JEFAE
NSIP
Upload SDA Sales Orders GACFP
Catalog Maintenance Sksh
Order Management From Date: | i to: | (&
Shipment Receipts MLT Date (Order by Date): |05/09/2019 ta: | |3
NW Delivery Calendar File Type Selection
(& XML File
" CSV File
2. Click * (the Hide Navigator button) to minimize the Portal menu. Note that this can be done

with any transaction in WBSCM.
Image: Download Catalog Screen

Home Operations Admin Reporis Help

Order Processing
Operations > Order Processing > File Uploads/Downloads > Download Catalog Full Screen || Options +

Catalog Selection
TEFAF
Program: NSIP A
CACFP
SFSP
NSLP W
nA
From Date: \ to: | |
NLT Date (Order by Date): [05/09/2019 | to: | gl
File Type Selection
% XML File
" CSV File
3. Select the appropriate option from the Program drop-down list.

@ (Note) Hold the Ctrl key to select more than one program. All USDA program catalogs are
available for selection.
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4, As required, complete/review the following fields:
Field R/O/C Description
From Date: R Beginning value to be entered when specifying a
date range.
Example:
06/02/2019

@ (Note) Use the To Date: field to enter
the end value for the date range.

NLT Date (Order by |[R No Later Than Date. The date by which an order

Date): needs to be placed in order to receive a specified

shipping date.

Example:
05/01/2019

(Note) Use the To Date: field to enter
the end value for the date range.

@ (Note) Enter dates in MM/DD/YYYY format, or click the calendar icon adjacent to the field to
select from the calendar.

Image: Download Catalog Screen

Home Operations Admin Reports Help

Order Processing
Operations > Order Processing > File Uploads/Downloads > Download Catalog Full Screen || Oplions ~

Catalog Selection

TEFAF
NSIP A
CACFP
SFSP
NSLP WV
na

From Date: [06/02/2019 | to: [06/01/2020
NLT Date (Order by Date): [05/08/2018 | to: | sl

Program:

File Type Selection

(* XML File
(" GSV File

5. Under File Type Selection, select © (the Radio button) beside the desired download format for
the file. In this example, CSV File is selected.

@ (Note) XML is usually used to upload the file into another system. CSV displays data in a
spreadsheet format.
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Image: Download Catalog Screen

Home Operations Admin Repaorts Help

Order Processing
Operations > Order Processing > File Uploads/Downloads > Downlead Catalog Full Screen || Options v

Catalog Selection

TEFAF
Program: NSIP i~
CACFP
SFSP
NSLP W
na
From Date: [06/02/2019 | to- [06/01/2020 |
NLT Date (Order by Date): [05/09/2019 | to- | |l

File Type Selection

(" XML File
(= GSV File

6. Click (the Submit button) to apply the selected options and initiate the download.

Image: Download Catalog Screen

Home Operations Admin Reports Help

Order Processing
Operations > Order Processing > File Uploads/Downloads > Download Catalog Full Screen || Oplions ~

Catalog Selection

TEFAF
Program: NSIP i

CACFP

SFSP

NSLP v

na
From Date: [06/02/2019 | to- | )

NLT Date (Order by Date): [05/09/2018 | to: | B

File Type Selection

" XML File
( CSV File
Do you want to open or save Product_Catalog.C5V from wbscmint.wbscm.usda.gov? Open Save (T Cancel
. . . . Open .
7. An option displays to select a download action. In this example, (the Open button) is
selected.

@ (Note) Download file prompt may appear different based on the user's browser. To
download in Chrome, refer to the Download/Export Document section in the WBSCM

Portal Navigation job aid.

Page 4 of 6
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@ (Note) Options include:

e Open displays the downloaded data in the appropriate application. For CSV files,
this is the user's default spreadsheet software (for example, Excel). The file is not
automatically saved.

e Save prompts the user to select a location to save the file. The file is not
automatically opened for viewing.

e Cancel exits the process without downloading the catalog.

Image: Microsoft Excel Spreadsheet

= = Product_Catalog.CSV - Excel

Insert Page Layout Formulas Data Review View Help ACROBAT Q Tell me what you want to do |& Share

&D 3{3 Calibri i e == _ - ab General h %Conditioﬂal Formatting = %’-"Insert - - éf' o
Ey - $ + 9% o [Formatas Table~ ExDelete + [¥]v O~ ]

Paste " B I U-~-|f~|d- A- == = E o |l an & Fleds B o B B ShErEThIS Webex

- d0 3.0 7 Cell Styles [=] Format = -
Clipboard = Font ) Alignment & Number & Styles Cells Editing Webex -
Al = fe | Catalog_ID: v
A B C D E F G H | 1 K L [ N (o] -

1 ICatan&lllZFNSfCATALOG

2 |Program_ Program_!Material_jProgram_i Order By Material_| Matl_DestMaterial_| Available End_Date

3 |NSLP Direct Del Flour Entitleme 20190615 100913 FLOUR PIELB 0 20190715

4 |NSLP Direct Del Flour Entitleme 20190715 100913 FLOUR PIELB 0 20190815

5 |NSLP Direct Del Flour Entitleme 20190815 100913 FLOUR PIELB 0 20190915

6 |NSLP Direct Del Flour Entitleme 20190915 100913 FLOUR PIELB 0 20191015

7 |NSLP Direct Del Flour Entitleme 20191015 100913 FLOUR PIELB 0 20191115

8 |NSLP Direct Del Flour Entitleme 20191115 100913 FLOUR PIELB 0 20191215

9 |NSLP Direct Del Fruits (Car Entitleme 20190615 100210 APRICOT ECS 0 20190715

10 |NSLP Direct Del Fruits (Car Entitleme 20190715 100210 APRICOT ECS 0 20190815

11 |NSLP Direct Del Fruits (Car Entitleme 20190815 100210 APRICOT ECS 0 20190915

12 |NSLP Direct Del Fruits (Car Entitleme 20190915 100210 APRICOT ECS 0 20191015

13 |NSLP Direct Del Fruits (Car Entitleme 20191015 100210 APRICOT ECS 0 20191115

14 |NSLP Direct Del Fruits (Car Entitleme 20191115 100210 APRICOT ECS 0 20191215

15 |NSLP Direct Del Fruits (Car Entitleme 20191115 100283 FIG PIECESCS 0 20191215

16 |NSLP Direct Del Meat Entitleme 20190615 100127 BEEF CAN-CS 0 20190715

17 |NSLP Direct Del Meat Entitleme 20190715 100127 BEEF CAN-CS 0 20190815

18 |NSLP Direct Del Meat Entitleme 20190815 100127 BEEF CAN-CS 0 20190915

19 |NSLP Direct Del Meat Entitleme 20190915 100127 BEEF CAN-CS 0 20191015

20 |NSLP Direct Del Meat Entitleme 20191015 100127 BEEF CAN-CS 0 20191115

21 |NSLP Direct Del Meat Entitleme 20200112 100127 BEEF CAN-CS 0 20200115

22 |NSLP Direct Del Meat Entitleme 20190615 100165 BEEF ROA!CS 0 20180715

23 |NSLP Direct Del Meat Entitleme 20190715 100165 BEEF ROA!CS 0 20150815

24 |NSLP Direct Del Meat Entitleme 20190815 100165 BEEF ROA!CS 0 20180915
251 i}

irect Nel Meat Entitleme 20190915 100165 BEFF ROA C 20191015 -
Product_Catalog ® “ »

Ready H m - 1 + 100%

Review the downloaded data. For additional information on fields included in the download file,
refer to FNS resources for WBSCM data files.

The transaction is complete.

Friday, March 11, 2022 © WBSCM Training - Proprietary Page 5 of 6



w B S ( M _j Vlslgr\i:vlgrg;giogatalog

RESULT

The user has downloaded a copy of the catalog based on the program and date selections. Depending on
the file format and downloaded action selected, the catalog may be viewed, printed, or saved as a
spreadsheet (CSV) or saved for uploading to another system (XML).
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